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Notice to Canadian Customers

This Class B digital apparatus complies with Canadian
standard ICES-003.

Notice to U.S. Customers

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is
operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction
manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own
expense.

Notice to Customers in EU Countries

If the CE mark appears on this product it indicates that this
product is in compliance with the 89/336/ EEC EMC directive,
Class B emissions. It also indicates that this product complies
with 73/23/EEC Low Voltage directive.

IMPORTANT! This device is designed for connection to a
MITEL telephone system. DO NOT connect directly to the
public-switched telephone network.

® Trademark of MITEL Corporation
© Copyright 1999, MITEL Corporation
All Rights Reserved. Printed in Canada



Contents ▼ iii

Contents
Getting Started ................................................................................ 3

Introduction .......................................................................................................... 4

Console Components ............................................................................................. 4

Console Screen ...................................................................................................... 5

Console Keypad ..................................................................................................... 6

Softkeys (F1 – F12) ................................................................................................ 7

Handset and Cradle............................................................................................... 7

Starting and Closing the Superconsole 2000 ......................................................... 8

Adjusting the Console............................................................................................ 9

Call Handling Basics ..................................................................... 13
Answering Calls................................................................................................... 14

Dialing Telephone Numbers................................................................................. 16

Extending (Transferring) Calls ............................................................................. 18

Holding and Retrieving Calls................................................................................ 20

Conference Calls.................................................................................................. 21

Answering Recalls................................................................................................ 22

Recovering the Last Released Call........................................................................ 22

Advanced Features ....................................................................... 25
Account Codes..................................................................................................... 26

Bulletin Board ..................................................................................................... 26

Call Answering Priority ........................................................................................ 27

Call Park ............................................................................................................. 28

Call Waiting Threshold ........................................................................................ 29

Cancel Call Forwarding ....................................................................................... 29



iv ▼ Contents

Clear All Features ................................................................................................ 29

Data Calls............................................................................................................ 30

Day and Night Service ......................................................................................... 31

Do Not Disturb (Extensions) ................................................................................ 32

Feature Access Codes .......................................................................................... 33

Firmkey Programming ......................................................................................... 33

Message Waiting.................................................................................................. 34

Operator Absent/Present Status.......................................................................... 35

Override............................................................................................................... 35

Paging ................................................................................................................. 36

Phone Book ......................................................................................................... 37

Scratch Pad ......................................................................................................... 38

Serial Call............................................................................................................ 38

Trunk Group Status Display................................................................................ 39

System Speed Call ............................................................................................... 40

Tone Signaling..................................................................................................... 40

Hotel/Motel Features......................................................................43
Displaying and Changing Room Information........................................................ 44

Searching for Rooms............................................................................................ 45

Changing Room Occupancy and Condition Status............................................... 45

Checking-In/Checking-Out ................................................................................. 46

Setting and Clearing Wake-up Calls .................................................................... 46

Setting Call Restrictions ...................................................................................... 47

Blocking Room-to-Room Calls ............................................................................. 47

Monitoring Guest Rooms ..................................................................................... 48

Clearing the Message Register ............................................................................. 48

Printing Reports .................................................................................................. 48



Contents ▼ v

Reference....................................................................................... 51
Superset 700 vs. Superconsole 2000 ................................................................... 52

Keyboard changes................................................................................................ 52

Screen changes.................................................................................................... 53

New features........................................................................................................ 53

Discontinued/Changed Features ......................................................................... 53

Alarms................................................................................................................. 54

Alarm types ......................................................................................................... 54

Greetings............................................................................................................. 54

Rerouted Calls ..................................................................................................... 55

Class of Restriction.............................................................................................. 56

Class of Service.................................................................................................... 56

Feature Access Codes .......................................................................................... 57

Glossary .............................................................................................................. 58

Hunt Groups ....................................................................................................... 60

Paging Zones ....................................................................................................... 60

System Speed Call List ........................................................................................ 61

System Messages................................................................................................. 62

Telephone Directory............................................................................................. 68

Trunk Numbers ................................................................................................... 68

Index............................................................................................... 69





Getting Started





Getting Started ▼ 3

Getting Started
 Contents

Introduction ........................................................................................................................ 4

Console Components........................................................................................................... 4

Starting and Closing the SUPERCONSOLE 2000 .................................................................. 8

Adjusting the Console ......................................................................................................... 9



4 ▼ Getting Started

Introduction
The Mitel Superconsole 2000 is an attendant console and PBX
administration application for the SX-2000 telephone system. It
features a specialized keypad and an intuitive user interface for
smooth, efficient call handling.

A note about feature availability
The features available on your telephone system have been
selected by your company and may not include all the features
described in this guide.

Before you begin using the console
Take a few minutes to explore this guide — it contains all the
information you need to operate the Superconsole 2000.

The first section introduces you to the console. You will learn
about the console keypad and what the Function keys on the
computer keyboard do. You will also learn about the console
screen and how to interpret the information it displays.

If any problems occur while you are using the console, contact
your communications department for assistance.

Are you an experienced Superset 700™ user?
The Superconsole 2000 will look familiar to users of the
Superset 700 attendant console. The consoles also work alike –
enough that experienced Superset 700 users can probably begin
handling calls with the Superconsole 2000 right away. Still, it may
help to read the section of page 52, which describes the differences
between the consoles.

Conventions used in this guide
Throughout this guide, the fixed-function keys and firmkeys
(both key types are explained later in this section) are in bold
type—for example, Answer or Release.

Softkey commands that appear on your screen and correspond to
the Function keys (F1, F2, F3, etc.) at the top of your keyboard
are shown in brackets— for example, [Source] or [Destination].
See page 7 for more information about softkeys.

Console Components
Your Superconsole 2000 Attendant Console consists of a
personal computer (PC) with monitor, a standard computer
keyboard, a keypad, a mouse and a handset with cradle.

The monitor displays call-handling prompts and call status
information. Use the keypad for all call-handling functions,
including dialing. The handset (or optional headset) is for talking
with callers.

You use the computer keyboard to find entries in the Phone Book
or to type in the Scratch Pad or Bulletin Board. The Function
keys (F1, F2, F3, etc.) at the top of the keyboard execute the
softkey commands that appear on the screen.
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Console Screen
The Superconsole 2000 screen is divided into five areas:

•  The Console Status area shows you at a
glance what state the console and the system
are in—for example whether the console
ringer is on or off and whether the system is
in Day or Night Service.

•  The Application area is divided into four
sections: The top left section displays
information about calls on hold; the top right,
a Phone Book for finding users on the system
and other tools such as an electronic scratch
pad for taking notes. The bottom two areas
display information on the Source (calling
party) and Destination (called party) of all calls
handled by the console.

The information displayed includes the name
of the party, extension or trunk number or
trunk label, type of extension (e.g., Superset),
status of call (e.g., ringing), privileges
assigned to the trunk or extension, and the
type of call (e.g., Conference, Recall, Serial).

•  The Call Waiting area displays an icon ( )
as a visual indication of incoming calls. The
icon appears above the softkey that’s used to
answer the call. You can tell how many calls
are waiting by the color of the icon: yellow

( ) for one call; blue ( ) for two calls and

red ( ) for three or more calls.

• The Softkey areas at the bottom of the screen
and above the Destination area display the Softkey
commands. The commands correspond to the
Function keys on the computer keyboard. See the
next section for more information on the Softkeys.

•  The Response area at the bottom of the
screen displays the date and time, the
number of calls waiting to be answered, and
messages received from the system.

Console
Status Area

Softkey Area

Response Area

Application
Area

Call Waiting
Area
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Console Keypad
The console keypad is used for dialing, call processing and
accessing PBX features. You can adjust the slope of the keypad
and detach (or attach) it from the handset cradle.

The keys on the keypad are arranged in three groups:

Volume and Mute Keys  – used to increase (+) or decrease (-) the
ringer volume and the volume of the earpiece in the handset or
headset. The Mute key turns the microphone in the headset or
handset on or off.

Call-processing Keys – fixed-function keys that are used to
answer and manage calls. They include Retrieve, Hold, Answer
Cancel, Recover and Release.

Firmkeys – programmable keys that provide access to the
following console features and system services:

SCRATCH
PAD

Displays an electronic notepad where you can type
messages from callers, reminders, questions, or
anything else you would write on note paper. You
can also use the Scratch Pad to store telephone
numbers for speed dialing.

BULLETIN
BOARD

Displays an area where you can type messages
that can be viewed from all other Supersconsole
2000s on the system.

GUEST
SERVICE

Displays room status information and softkeys
for managing guest services in a Hotel/Motel
installation.

PAGER Accesses paging equipment for making
announcements.

HELP Opens Help, which provides information to help
you accomplish your tasks.

OPERATOR
MODE

Re-displays the main console screen.

PHONE
BOOK

Allows you to find and call an extension by
typing the user’s name, extension number or
other information.

APPL Starts another application that extends the
capabilities of the Superconsole 2000. Your
communications department selects the
application.

TRUNK
STATUS

Displays information about trunk (outside line)
usage.

MESSAGE Displays softkeys for setting or clearing the
Message Waiting indicator on the dialed
extension.       

TONES Sends subsequently dialed digits as tones (used
when dialing into voicemail systems.)

VOICE
MAIL

Transfers a recall to an extension user’s
voicemail box.

Note: Some of the features shown are optional and may not
appear on your console keypad. Other features can also be
programmed to the keypad; see Firmkey Programming
on page 33.

Call-
processing
Keys

Firmkeys

Volume and
Mute Keys
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Softkeys (F1 – F12)
The softkeys are the F1 to F12 keys on your computer keyboard.
You use them to enter commands shown in the softkey area on
the screen. The commands are not fixed to a specific softkey;
instead, they change depending on the state of the call you are
handling or the feature you are using. For example, when you
call a busy extension, the F4 key might be used to request a
Callback. At another time, the same key, F4, could be used to set
up a conference call.

Handset and Cradle
The Superconsole 2000 is equipped with a handset and cradle.
You can adjust the slope of the cradle and detach (or attach) it
from the console keypad.

Mitel-approved headsets are also available for use with the console.

See page 9 for more information about using the handset or a
headset.
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Starting and Closing the
Superconsole 2000
The Superconsole 2000 starts with the operator status set to
“Operator Absent.” To begin receiving calls, you must change the
status to “Operator Present.” For more information, see page 35.

To start the Superconsole 2000 application

•  Start Windows.

•  Type your user name and password.

For turnkey consoles, the default user name and password
are mitelconsole and mitel1 respectively. Type both in
lowercase letters.

•  Click  on your Windows desktop.

To close the Superconsole 2000 application

•  On the File menu, click Exit.

Starting a CDE Session
Starting a CDE session provides access to the PBX for
programming and maintenance purposes. Access requires
authorization (i.e., a user name and password) and is usually
restricted to trained technicians. A connection to your local area
network is also required—see the Superconsole 2000 Help for
more information.

To start a CDE Session

•  On the File menu, click Connect to CDE.

Questions about Starting and Closing the
Superconsole 2000 application

What happens to incoming calls when I close the
Superconsole 2000 application?

If yours is the only console on the system, the system
automatically switches to Night Service 1. Calls then ring
night bells or another designated answering point. If there are
other consoles, yours will switch to Operator Absent status
when you close the application. Other answering points will
receive the calls that would otherwise go to your console. For
more information, see Day and Night Service on page 31 and
Operator Status on page 35.

What happens to calls if my computer stops working?

Usually, a nearby extension will serve as a backup answering
position in the event of a power failure or other problem that
causes your computer to stop working. Calls that normally
ring the console would then ring the backup extension.

Can I use other applications while the Superconsole
2000 is running?

Yes, but keep in mind that having multiple applications open
at the same time as the Superconsole 2000 can adversely
affect its performance. If possible, try to limit your use of
other applications to periods when call traffic is low.

My screen goes blank sometimes—why?
A power-saving feature built into the computer automatically
reduces the screen intensity when there has been no keyboard
or mouse activity for approximately two minutes. After approxi-
mately five minutes, the screen goes blank. When you press the
spacebar on the keyboard, the console screen will reappear.

theriaul
Text Box
  NOTE: To launch the SUPERCONSOLE 2000 in Windows XP, you
  must log in at the administrator level.
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Adjusting the Console
The console is designed with your comfort in mind. You can
make adjustments to the ringer, the language of text on the
screen, the angle of the keypad, whether you want to handle calls
using a handset or headset and more.

Console Ringer

To turn the console ringer on or off

•  Select Ringer On or Ringer Off from the list in the
Console Status area.

When the ringer is off, the call waiting icon ( ) is the only
indication that you have calls waiting.

To adjust the ringer volume

•  While the console is ringing, press the     key on the console
keypad to set the volume to the level you want.

You can also use the Options command on the Tools menu to
adjust the ringer volume.

Console Keypad and Handset Cradle

You can adjust the slope of the keypad and detach (or attach) it
from the handset cradle.

To attach the handset cradle
to the console keypad

•  Align the tabs on the
clamp with the slots on the
bottom of the keypad.

•  Press to seat the tabs in
the slots.

To detach the clamp from
the keypad

•  Grasp the keypad as shown.

•  Place your thumbs along
the edge of the clamp, and
then press down and away
from the keypad.

To detach the clamp from
the cradle

•  Using your finger or a tool
such as a screwdriver, push
against either of the tabs as
shown.

•  While pushing on the tab,
use the other hand to twist
the U-clamp upward.
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Handset/Headset
The console keypad provides jacks for connecting a handset and
a headset. One jack is labeled for headset use only, the other for
either handset or headset use. Both jacks can be in use at the
same time but when they are, the dual-use jack is used for
listening only. (Typically, a supervisor uses the dual-use jack to
monitor a new attendant during training.)

Connect Mitel-approved headsets only to the keypad. For a list of
approved headsets, see the Superconsole 2000 Installation Guide.

The dual-use jack provides different audio levels for headsets and
handsets.  Use the  list to indicate which one—headset or
handset— is connected to the jack.

To set the dual-use jack for handset or headset operation

1. Plug the handset or headset into the dual-use jack ( ) on the
back of the console keypad.

2. Select Handset or Headset from the list in the Console
Status area.

To adjust the handset (or headset ) volume during a call

•  Press the     key on the console keypad to set the volume to
the level you want.

You can also use the Options command on the Tools menu to
adjust the volume. After selecting the command (either during a
call or while the console is idle) click Audio, and then drag the
slider to set the volume to the level you want.

Console Language
Text on the console screen can appear in English (the default) or
French.

To change the console language

1. Choose Options on the Tools menu.

2. Select Language.

3. Select the language you want.

4. Click Apply or OK.

The change takes effect when you restart the Superconsole 2000.

Console Time
You can use either the PBX clock or the clock in your PC as the
time source for the console. Using the PBX clock is recommended
since it’s the time source for extensions in the system.

You should also use the PBX clock if you set wake-up calls for guests.
(Setting wake-up call applies to hotel/motel systems only.)

To set the console time

1. Choose Options on the Tools menu.

2. Select Time.

3. Select the option you want.

4. Click Apply or OK.

Unplugging the Handset or Headset
Unplugging the handset or headset from the console keypad
automatically enables the other if it is plugged in. If neither is
plugged in, the console changes to Operator Absent status.
Or, if you are the last active attendant, the system goes into
Night Service 1 mode.

Note that plugging the handset/headset back in does not
change the Operator status back to Present.
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Answering Calls
When a new call arrives at the console the bell rings (if it is turned

on) and a call waiting icon ( ) appears above the softkey associated
with the call.

You can answer calls on a “first-come, first-served basis,” using
the Answer key or use the softkeys for “selective answer.”

Note: You cannot answer a new call until the one you are
engaged in is transferred, disconnected, or put on hold.

Answering calls on a first-come, first-served basis,
With both the Source and Destination areas clear,

•  Press Answer

to greet the caller who was waiting the longest. Information
about the call, such as the trunk name and number for an
external call or the caller’s name and extension number for
an internal call, is displayed in the Source area.

Note: The Answer key has a hierarchy; recalls are answered first,
then any other call in order of arrival, regardless of whether it is
an internal or external call. You can assign answering priorities
to calls based on the telephone number that callers dial to reach
the console. For more information, see page 27.

Selectively answering calls
You can select the call you want to answer by pressing a softkey
([Recall], [Dial 0], [External], [WATS], etc.) instead of the Answer
key. If you have more than one call waiting at a particular softkey,
then they will be answered on a “first-come, first-served” basis.

Use the call waiting icons ( ) in the Call Waiting area to help
you decide which type of calls to answer first. The icon appears
above the softkey associated with the various call types (external,
recalls, etc.). The number below the icon shows you how many
calls of a particular type are waiting. The color of the icon also
indicates the number of calls waiting: yellow for one call, blue for
two calls, and red for three or more calls.

About the Call Answering Softkeys
The call answering softkeys are assigned by your
communications department to suit the types of calls your
company receives.

The leftmost softkey is reserved for recalls (see Answering
Recalls on page 22), but the other softkeys may be
programmed in a variety of ways. For example, you might
have Dial “0” and “External” to indicate whether a call is
from outside the system or inside; or WATS or TIE to tell you
the type of trunk the call arrived on; or you might see the
department name assigned to the trunk.

You can use the softkeys to guide you when answering a call.
For instance, when you see that a call is from outside the
system, your company might want you to answer with a
different greeting than you use for internal calls or recalls.
Use the form provided on page 49 to record your company’s
preferred greetings.

Call Waiting
indicator

Total Calls Waiting
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In the example above, note that one internal [Dial 0] call is
waiting and two external calls are waiting. If you:

•  press Answer, you will be connected to whichever of the three
calls arrived at the console first;

•  press [Dial 0], you will answer the internal call; or

•  press [External], you will answer the outside call which
arrived at the console first.

Your communications department can give you instructions on
which types of calls it prefers you to answer first.

Questions about Answering Calls

Why do I sometimes hear a short burst of ringing
while I’m handling calls?

Either a new call has arrived or a call on hold has recalled. As
you are already handling a call, the console only rings once.
You may turn down your volume control if you wish. You can
also turn off the bell completely by using the    list in the
Console Status area. (WARNING: This also turns off all other
bell indications, including the Critical Alarm bell.)

What does the caller hear while I’m dialing the
extension number?

Once you start to dial, the caller is on Consultation Hold until
you have completed dialing, established communication with
the called party, and released the caller to the called party. If
music on hold is provided on your system, the caller will hear
music; otherwise silence.

Can I answer another call while still connected
to the first?

No. Before you can answer a new call, you must transfer the
current call to another destination (see page 18), put it on
hold (see page 20), or disconnect it from the console by
pressing Release.

Why do extension numbers appearing in the Source and
Destination area sometimes have a ‘p’ n front of them?

When it appears next to an extension, it means that the
extension is designated as private. Attendants see the
number of the extension on their screens; other extension
users see only the user’s name (if available) on their display.

In the Phone Book, the  icon indicates a private extension.
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Dialing Telephone Numbers
You can dial an internal extension number or the number of a
telephone outside the system. Either the Source or Destination
areas must be clear.

To call an extension

1. Dial the extension number from the console keypad.

Information about the extension appears in the Destination
area. If information about an answered call is currently in the
Destination area, that information moves to the Source area
as soon as you start dialing.

2. Press Release

to release the call. If the extension is busy, the transferred
call will automatically camp on to the line to wait until it
becomes free. You can also handle the call in one of the
following ways:

If the extension is busy

•  Press [Source]

and ask what the Source party would like to do. This leaves
the Destination information displayed so that you can easily
take a message and set Message Waiting on the destination
extension, if required. (See Message Waiting on page 34.)

Or

•  Press Cancel

to cancel the call. The caller remains in the Source area, but
the information in the Destination area is lost, which makes
setting Message Waiting more difficult.

Or

•  Press [Override]

to intrude into the Destination party’s call if permitted by
your and the extension’s Class of Service (see Override on
page 35).

To call an outside number

1. Dial the External Line Access Code ( ______ )*.

2. Dial the telephone number.

Information about the outside call appears in the
Destination area.

Leaving a Callback
You can request a Callback after reaching a busy line (extension
or trunk). The system monitors the line and rings the console
when the line becomes free. Note that Callbacks on outside lines
are used when all system trunks are busy, not when the called
party is busy.

To leave a Callback after reaching a busy line

•  Press [Callback].

Placing an outside call for an extension
Extension users can usually place their own calls. However, they
could ask you to place a call for them. Before dialing, you may want
to note the extension’s COR number (see Class of Restriction on
page 58). Check with your communications department for specific
instructions on how to handle such requests.

To place an outside call for an extension

1. Answer the call from the extension.

2. Dial the External Line Access Code ( ______ )*.

3. Dial the telephone number.

4. Press Release

to release the call from the console and connect the extension
to the outside line.

* Use this space to record the digits you dial to access
an outside line.
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Other ways of dialing
You can use the following alternate ways of dialing a telephone
number:

Last Number Redial – instead of redialing the number of the last
outside call you placed, let the system do it for you by dialing the
Last Number Redial code ( ______ ).*
System Speed Call – allows you to dial a telephone number by
entering a short access code. See System Speed Call on page 40.

Dial from Phone Book – useful when you don’t know the full
name of the person you are asked to find or you only know the
person’s location or department. See Phone Book on page 37.

Dial from the Scratch Pad  – allows you to dial a telephone number
you typed on an electronic notepad. See Scratch Pad on page 38.

* Use this space to record the code you dial to use the Last Number
Redial feature.

Questions about Dialing Telephone Numbers

Can I access a specific trunk?

Yes, you can select a specific trunk to dial out on.

•  Dial the Individual Trunk Access Code ( ______ ).*

•  Dial the three-digit trunk number.

•  When you hear dial tone, continue dialing the
telephone number.

If you hear busy tone, the trunk is in use. You can,

•  press [Override] to interrupt the call in an emergency

Or

•  press Release or Cancel to release the console from
the trunk.

What do I do if I make a mistake while dialing?

If you notice the mistake before you complete dialing, press
Cancel, and then re-enter the number.

If you realize you transferred a call to the wrong extension,
press Recover to cancel the transfer and reconnect the
caller. You can only recover a call while it is still ringing at
the extension to which it was originally transferred.

* Use this space to record the digits you dial to access a specific
trunk.

Options
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Extending (Transferring) Calls
You can transfer a call to an extension or an outside number.

To transfer a call

1. Dial the destination number.

The caller is automatically placed on Consultation Hold while
you complete the transfer.

2. Press Release to connect the caller to the ringing phone.

If the called party fails to answer within a time-out period,
the transferred call (if it is an outside line) returns to the
console as a Recall.

Reaching a Busy Number or an Extension
with Do Not Disturb Activated
If the dialed number is busy or the extension has Do Not Disturb
activated, do one of the following:

•  Press [Source]

to talk with the caller in Source without losing the Destination
information. Tell the caller the requested number is busy and
ask if the caller wants to try again later or leave a voice mail
message for the busy party (see Options on the right). You
can also take a message and send the busy party a message
waiting indication (see Message Waiting on page 34).

Or

•  Press Cancel and then dial a different number

if you think you can locate the requested party elsewhere.

Or

•  Press [Source], and then [Redial Dest]

to redial the same destination number

Or

•  Press [Override]

to intrude into the extension user’s call (if permitted by
your and the extension’s Class of Service. See Override on
page 35.)

Or

•  Press Release

to camp the caller on to the busy extension. (Camp-on is not
allowed if the extension has Do Not Disturb activated.) The
extension user hears two beeps to indicate a call is waiting.
When the user hangs up, the extension rings and the waiting
call is automatically connected.

Notes:  If there is no answer after a time-out period, the
transferred call (if it is an outside line) returns to the console
as a Recall.

Introducing the caller before completing the transfer
After your call is answered and you’ve had the chance to speak
with the person privately,

1. Press Release to complete the transfer.

Or

2. Press [Source]

to speak privately to the party in Source; the party in
Destination is on Consultation Hold. To speak privately to the
party in Destination again, press [Destination].

Transferring a call to a voicemail box
The Voicemail key on the console keypad allows you to transfer
calls directly to an extension user’s mailbox. You can use the key
for transferring recalls only—that is, calls returned to the console
because the extension went unanswered.

Note: This feature requires an access code, which must be
entered into the console using the Options command on the
Tools menu. For more information, see page 33.

Options
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Transferring a call to an outside number
You can request a meter pulse count for the call from the
telephone company operator. Upon completion of the call, the
console will ring. When you answer, the meter pulse count will
display on the console screen. Ask your communications
department for further information about this feature.

Questions about Transferring Calls

What do I do if the destination to which I am
transferring a call is not answering?

•  Press [Source] to reconnect the Source call and retain
the Destination information. This gives you more options
to handle the call because softkeys, such as [Redial
Dest], remain on screen.

Or

•  Dial a different number if you think you can locate the
requested party elsewhere.

Or

•  Press Cancel to reconnect to the Source call but clear
the Destination information.

Do I need to press Release when answering several
calls in a row?

No. If you use the Answer key to answer calls, pressing the
key will transfer the current call to the dialed destination
and connect you to the next call waiting. This only works if
you have calls in both the Source and Destination areas.

What should I do if a caller wants to speak
to one person, and then another?

If an outside party wants to speak with several people in a
row, use the Serial Call feature (see page 38). When the
outside party completes the first call, you receive a Recall
and can then dial the next person’s number.

Can I transfer a call to another console?

Yes, by dialing the extension number of the other console.
You can transfer calls to other consoles but you cannot put
another attendant on hold.
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Holding and Retrieving Calls
You can place up to six callers on hold while you check for
information or page the person that the caller is requesting.

To place a call on hold

•  Press Hold.

Information about the call appears in the Calls On Hold area.

To retrieve a call on hold

You can retrieve a call on hold only when the Source and/or
Destination area on the screen is clear.

•  Press Retrieve, and then dial the position number of the call
(1-6) you want to retrieve.

Or

•  Press Retrieve and then the star key (*) on the keypad to
retrieve the longest-held call.

Hold Recall
If a call is left on hold longer than the time-out period, it recalls
the console. The console beeps (or rings if you are not engaged in

a call) and a Call Waiting icon ( ) appears in the Calls On Hold
area next to the call that is recalling. Answer the recall using the
procedure for retrieving a call on hold.

To connect a call on hold to the Source or Destination party

1. Press Retrieve.

2. Dial the position number of the call (1-6) you want to retrieve.

3. Press [Source] or [Destination]

if you want to speak privately to either party.

4. Press Release

to connect the parties and release the console from the call.

To connect two calls on hold

Be sure the Source and Destination areas are both clear.

1. Press Retrieve, and then dial the position number of the first
call on hold.

Information about the call appears in the Source area.

2. Press Retrieve and dial the position number of the second
call on hold.

Information about the second call appears in the Destination
area.

3. Press Release

to connect the parties and release the console from the call.

Questions about Hold and Retrieve
Can I place a conference on hold?

Yes. If you can’t find a person needed for the conference,
you can place the conference on hold until you locate the
person. For more information, see page 21.

What does  in the Calls On Hold area signify?

It signifies that the call was the last one placed on Hold.

Options
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Conference Calls
Up to eight parties (including yourself) may be connected to form
a conference call.

To set up a conference call

•  With the two parties connected to the console—one in the
Source area and the other in the Destination area—press
[Conference].

To split a conference to speak privately to either caller

•  Press either [Source] or [Destination].

To add more parties to a conference

1. Dial the number of the next party.

The word “Conference” and a Conference number now appear
in the Source area, and the number of the dialed party
appears in the Destination area.

2. Press [Conference].

The new party is added to the conference. The parties already in
the conference hear a brief tone each time a party is added.

If the line is busy or unanswered or the person is
unavailable,

•  Press Cancel.

to reconnect to the conference. You may continue dialing to
add more parties to the conference.

To release the console from the conference

•  Press Release.

Once you release the conference, you cannot re-enter it.

Placing a Conference on Hold
If you can’t find someone needed for the conference, you can place the
conference on hold until you are able to locate the person.

To place a conference on hold

•  Press Hold.

The conference is on hold. The parties in the conference can
speak to each other—only you are removed from the call.

Check on the conference periodically, because the parties in
the conference cannot get in touch with you.

To retrieve a held conference

You can retrieve a conference only when the Source and/or
Destination area on your screen is clear.

1. Press Retrieve.

2. Dial the hold number of the held conference.

Options
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Answering Recalls
If an external call transferred from the console to an extension is
not answered with a certain time, the call returns to the console

as a recall. The call waiting icon ( ) appears above the [Recall]
softkey. Because Recalls are given priority, they will be answered
first when you press Answer. You can also use the [Recall]
softkey to answer recalls.

To answer a Recall

The Source and Destination areas must both be clear.

1. Press [Recall].

Or

2. Press Answer.

You are now connected and may ask if the caller wants to
continue waiting or wants you to ring another extension.

3. Depending on what the caller wants, you have several options
at this point:

•  Press [Redial Dest] if the caller wants to continue
waiting.

•  Dial another extension.

•  Press Release to disconnect the call.

•  Press Voicemail to transfer the caller to the extension’s
voicemail box.

Note: Serial calls will also recall the console. See Serial Call on
page 38.

Recovering the Last Released Call
Use the Recover key on the console keypad to retrieve a call that
you transferred to the wrong extension. To successfully recover
the call, you must press Recover while the extension is still
ringing. Also, you cannot have started another action, such as
dialing or answering a call, following the transfer.

To retrieve the last call transferred from the console

• Press Recover.

Note: This feature requires an access code, which must be
entered into the console using the Options command on the
Tools menu. For more information, see page 33.



Advanced
Features
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Account Codes
An Account Code is a type of password for the system. You may
need to enter an account code to access certain features or to
record a call on the SMDR log for billing or accounting purposes.

To enter an Account Code

1. Dial the Verified or Non-Verified Account Access Code.

A Verified code provides access to features; a Non-Verified
Code records calls on the SMDR log.

2. Dial the Account Code, ending in #.

If you make a mistake, press Cancel and try again.

3. Continue dialing.

For more information about Account Codes, contact your
communications department.

Bulletin Board
The Bulletin Board is shared by all Superconsole 2000s on the
system that have a network connection. Use it to post
information that you want other attendants to see and to store
speed dial numbers that all attendants can access.

To post information on the Bulletin Board

1. Press Bulletin Board.

2. Press [Edit].

Only one person at a time can edit the Bulletin Board; if
someone else is editing it, the Bulletin Board background will
remain gray after you press [Edit].

3. Type the information you want to post.

4. Press [Save].

To view the most recent changes to the Bulletin Board, press
[Refresh].

To dial a telephone number posted on the Bulletin Board

1. Select the telephone number using the mouse or the
computer keyboard.

2. Press [Call] or double-click the selected number.

Note: Information posted on the Bulletin Board is stored in a file
on your network. The actual location of the file is determined
during installation of the console. If the file is moved, enter the
new location, using the Options command on the Tools menu.
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Call Answering Priority
The console is usually set up to answer incoming calls on a ‘first-
come, first-served’ basis. When you press the Answer key with
multiple calls waiting, the call that has been waiting longest will be
answered first. Alternatively, you can assign priorities to calls based
on their destination. For example, you might give higher priority to
calls to your company’s main listed directory number (LDN) than to
“Dial 0” calls (i.e., internal calls to the console). Your
communications department will tell you which type of call it prefers
you to answer first.

Note: The Answer key has a hierarchy when the console is set up
to answer calls on a first-come, first-served basis: recalls are
answered first, followed by other calls in order of arrival. If more
than one call is waiting at a particular softkey, they will be
answered on a “first-come, first-served” basis.

To specify which calls are answered first

1. Choose Options on the Tools menu.

2. Click Answer Priority.

3. Do one of the following:

•  To answer calls on a first-come, first-served basis, select
First-Come, First-Served.

•  To prioritize calls by line, select Assigned line priorities
and then enter a number from 1 to 7 for each line. The
lower the number the higher the priority.

4. Click Apply or OK.



28 ▼ Advanced Features

Call Park
Provided the appropriate access code is programmed into the
system, this feature allows an extension user to retrieve a call
that you put on hold, by dialing the Call Park - Remote Retrieve
access code, followed by the console identity number and the
hold position number displayed on your screen.

To park a call for retrieval by an extension user

1. Put a call on hold (see Holding and Retrieving Calls
on page 20).

The screen displays the call in the first available Hold
position—for example,

2. Page the requested party, informing him or her of the hold
position number.

In the example above, assuming that the caller on Trunk 25
(hold position 2) wants to talk to Mr. Smith, and that the Call
Park - Remote Retrieve Code is 69, you could page Mr. Smith
in the following manner: “Mr. Smith, please dial 69 152.”

The called party can then retrieve the call by dialing the Call
Park - Remote Retrieve access code (69 in the example),
followed by the two-digit console identity number (15 in the
example), and the hold position number (2 in the example).

When the called party retrieves the call, the call is removed
from the hold position on your screen.

Up to six calls can be parked at the console at any one time.

Questions about Call Park

What happens if the called party does not retrieve
 the call?

After a predetermined period of time, the call will
automatically recall your console.

What happens if I change the status of the console to
“Operator Absent” while I have parked calls?

The parked call will remain in the attendant hold position for
the same predetermined period of time. This allows system
users to retrieve calls parked at a console whose attendant
just left. After the predetermined period of time, all parked
calls (external and internal) are automatically routed to a
programmed answering point.
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Call Waiting Threshold
To reduce call-waiting times, your system may be programmed to
present incoming calls to other consoles or answering positions.
If your system is programmed this way, you can specify the
number of calls that must be waiting before the system presents
them to your console.

To set the call waiting threshold

1. Choose Options on the Tools menu.

2. Click Miscellaneous.

3. Enter a number in the Call Waiting Threshold box.

Cancel Call Forwarding
Call Forwarding lets an extension user route some or all calls to
other extensions. You can cancel Call Forwarding on behalf of
individual extension users, or for all extensions in the system.

To cancel all types of Call Forwarding for a single extension

1. Select Cancel All CFWD on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel Call Forward - Follow Me for a single extension

You can cancel Call Forward - Follow Me on an extension and leave
the other types of Call Forward (Busy and No Answer) alone.

1. Select Cancel Station CFFM on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel all Call Forwarding for all extension users

1. Select Cancel All CFWD on the Program menu.

2. Click Yes.

3. Click Yes again to confirm the cancellation.

Clear All Features
From your console you can disable features activated on any
extension in the system.

These are the features you can clear:

•  All Call Forwarding

•  Do Not Disturb

•  Callbacks to other users

•  Advisory Messages on SUPERSET  telephones

•  Auto-answer on SUPERSET telephones

•  Timed Reminder on SUPERSET telephones

To cancel all features on an extension

1. Select Cancel Station Features on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

Questions about Clear All Features
Will using Clear All Features on an extension have any
effect on Messages or Callbacks set on that extension by
other users?

No, it only affects features activated by the extension user.
Any Message notifications or Callbacks set on the extension
by others will still be in place. Similarly, Clear All Features
will have no effect on the station user’s Account Codes or
Class of Service.
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Data Calls
You may be asked to connect an outside caller to a data
connection for data communications.

To connect a caller to a modem

1. Advise caller to switch local modem to “Data” when they hear
the high-pitched modem tone.

2. Dial the modem number.

‘Modem Call’ appears in status area.

3. Dial the destination data terminal number.

‘Ringing’, and then ‘Connected’ appear in the Destination area
to confirm that you are connected.

4. Listen for the high-pitched modem tone.

5. Press Release
to connect the caller to the modem.

If the number is busy or there is no answer, press Cancel to
return to the caller in the Source area.

To set up a local Associated Data Linecall

1. Dial the Associated Data Line code.

If you hear silence, continue.

If you hear busy tone, the Associated Data Line is in use, or
is not ready.

2. Dial the destination data terminal number.

‘Ringing’, then ‘Connected’ appear in Destination. Listen for
Connect Tone.

3. Press Release.

Your data line is connected.

To set up an Associated Data Line Call to a remote facility

1. Dial the Data Access Code.

If you hear silence, continue.

2. Dial the modem hunt group number.

‘Modem Call’ appears in status area.

3. Dial the remote data facility number.

‘Seized’, and then ‘Connected’ appear in Destination.

4. Listen for Connect Tone.

5. Press Release.

Note: For faster dialing using Phone Book, ask your
communications department to add frequently dialed data
numbers to the system directory
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Day and Night Service
Office telephone systems are typically placed in Night Service
after regular hours, or whenever the last available console is left
unattended.

Calls then ring alternate answering points—either designated
extensions, or a night bell.

Extension users can dial the Trunk Answer From Any Station
(TAFAS) Code to answer incoming calls ringing the night bell.

If the last available attendant console has not processed a call
after a programmable time-out period, the system is
automatically placed in Night Service 1.

To change the service mode

•  Select the appropriate mode from the list in the
Console Status area.

Note: Contact your communications department for information
about where the answer points are and when you should select
the different services.

Questions about Day and Night Service
What services are affected by Day or Night Service?

The change from Day to Night service may effect some users
depending on their COS and COR. For example, a user might
have a COR that allows external calls when the system is in
Day service but not when in it is in Night service.
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Do Not Disturb (Extensions)
Extension users usually set and cancel Do Not Disturb (DND) on
their own phones but you may be asked to do it for them. When
set, DND prevents calls from ringing the extension.

To set up Do Not Disturb on behalf of an extension user

1. Select Set Station DND on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel Do Not Disturb on behalf of an extension user

1. Select Cancel Station DND on the Program menu.

2. Enter the extension number using the computer keyboard.

3. Click Yes.

To cancel Do Not Disturb for all extensions

1. Select Cancel All DND on the Program menu.

2. Click Yes.

3. Click Yes again to confirm the cancellation.

Questions about Do Not Disturb
Why would an extension user want to use
Do Not Disturb?

Do Not Disturb prevents most calls from ringing the
extension. Only recalls, overrides, and special trunks dialing
in directly to the extension will ring it. If extension users
want protection from tone intrusion (for instance, during a
data call) they should use Call Privacy instead.

What kind of tones does another extension user or
attendant get when calling an extension that has
Do Not Disturb set?

They hear slow busy signal. Anyone who is permitted to
override the other extension may then do so.
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Feature Access Codes
To use the Recover and Voicemail keys on the console keypad,
your console must be programmed with the correct access codes.

To program the Recover and Voicemail access codes

1. Choose Options on the Tools menu.

2. Click Miscellaneous.

3. Type the access codes in the appropriate boxes.

4. Click Apply or OK.

Firmkey Programming
You can reprogram the top two rows of keys on the console
keypad with other features or remove a feature from a key if the
feature is unavailable.

To program features to keys

1. Choose Options on the Tools menu.

2. Click Keypad.

3. Using the right mouse button, click on the key that you want
to program.

A list of features appears.

4. Select the feature you want to assign to the key.

5. Repeat sets 3 and 4 to program other keys.

6. Click Apply or OK.

To restore the original key programming

•  Click Restore Defaults.
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Message Waiting
You can set (activate) a message waiting indicator on an
extension, to notify the user that you have a message for him or
her. You can also check whether an extension has a message
waiting and clear the message waiting indication.

If a dialed extension is busy, unanswered or has
activated Do Not Disturb

1. Press [Source] and take the message.

2. Press Message.

3. Press [Set MSG Waiting].

4. You can then,

•  press Cancel to return to the call in Source (if necessary),
and then

•  press Release to release the call in Source.

To set message waiting if you are not currently connected
or trying to connect with an extension

1. Press Message.

2. Press [Set MSG Waiting].

3. Dial extension number.

To cancel a Message Waiting indication

You can cancel a message waiting indication whether you are
connected to the extension or not.

1. Press Message.

2. Press [Clear MSG Waiting].

3. Dial the extension number (if not connected to the extension).

To check whether an extension has a message waiting

1. Press Message.

2. Press [Check MSG Waiting].

3. Dial extension number.

The words ‘MSG Waiting ON’ appear in the Destination area if
the extension has a message waiting.

Questions About Message Waiting

How do extension users know there is a message
waiting for them?
The indication depends on the type of telephone being used.
A SUPERSET 3™ SUPERSET 3DN™ telephone or standard
telephone user hears Message Waiting Tone upon lifting the
handset. (If the user’s phone has a message lamp, the light
flashes). Users with a SUPERSET 4, SUPERSET 4DN™ or
SUPERSET 4000-series telephone receive a Message Waiting
indication on the set’s liquid crystal display.

When should I cancel Message Waiting notifications?
You can do it whenever it is convenient for you; however, it
saves time and effort to do so at the same time as you deliver
the message to the extension user.

While you are delivering the message to the extension,

1. Press Message.

2. Press [Clear MSG Waiting].

3. Press Release when you finish the call.
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Operator Absent/Present Status
You can change the Operator status to Absent when you plan to
be away from your desk and do not want calls sent to your
console. All new and waiting calls will ring another destination
determined by system programming.

To change the Operator Present/Absent status

•  Select the state you want from the list in the Console
Status area.

If you are the only Attendant on the system and you attempt to
change the console status to Absent, a warning message will
appear on your screen: ‘Absent Feature Disallowed for Last
Attendant. Select Night Service.’ For more information about
Night Service, see page 31.

Note: Unplugging the handset or headset will automatically
change the Attendant Status to Absent. See Unplugging Handset
or Headset on page 10 for more information.

Override
You can interrupt a busy extension or intrude on a busy
outside line.

To intrude on a busy extension

1. Press [Override].

All parties in the conversation hear Override Tone (a brief
tone every six seconds) for as long as you are connected to
the call.

Everything you say is overheard by all connected parties.

The message ‘Feature not allowed’ appears if your Class of
Service does not allow you to override the extension.

2. After the override, you may,

•  press Release to disconnect the console from the call.

Or

•  press Cancel to reconnect to the call in Source and
disconnect from the call in Destination.

To intrude on a busy trunk (outside line)

1. Dial Individual Trunk Access Code.

2. Dial trunk number.

For a list of trunk numbers, use the Trunk Group Status
Display feature described on page 39.

3. Press [Override].

The callers hear Override Tone as long as you are connected
to the call. When they hang up, the line is available for
your use.

Questions about Operator Absent/Present Status

What happens to my calls when I activate
Operator Absent?
All new and waiting calls to your console are automatically
rerouted to programmed destinations. Calls that you may
have put on hold will time-out and either be given reorder
tone or redirected to the programmed destination. However,
you can still originate calls.

Note: If a console has not processed a call after a program-
mable time-out period, the console status automatically
changes to Operator Absent.
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Paging
If your system has paging equipment, you can use it to make
announcements to one or more areas or “zones.”

Use the Paging Zones table in the Reference section to record the
location of the paging zones.

To make a page

The Source and Destination areas of your screen must be clear.

1. Press Pager.

If you have only one paging zone, you will be immediately
connected to the pager.

2. Make your announcement.

If you have more than one paging zone

•  After pressing Pager, dial the 2-digit Paging Zone Code—(01-
15) or 00 for all zones.

Listen for a long beep. Once you are connected to the paging
circuit, one of these messages appears on your screen:

‘Page Zone Busy’ — someone else is accessing the paging
equipment. Try again later, or press [Override] (if this is
allowed in either your or the paging unit’s Class of Service) to
interrupt the page in progress.

‘Page Zone Unassigned’ — you do not have access to that
paging zone.

‘Connected to Pager’ — you are connected and can make your
announcement.

To end a page

•  Press Cancel or Release.

You are disconnected from the paging equipment.



Advanced Features ▼ 37

Phone Book
Use the Phone Book to search your system’s telephone directory
for people and extensions. You can search by entering a person’s
name, an extension number, a department, or a location.
Searching by department is useful when a caller requests to
speak to “someone in Sales” rather than a specific person. A
location could be a conference room, the lobby of your building,
or other place that has a phone. You can also make a call from
the Phone Book.

To access your system directory

You can access the directory at any time.

1. Press Phone Book.

2. Type the person’s name or other information in the
appropriate boxes. (Use the mouse or the Tab key to move
between boxes.)

Press Backspace to erase incorrect keystrokes.

3. Press [Search].

Entries that match what you typed appear in the
Phone Book area.

4. Use the mouse or the arrow keys or the PageUp/PageDown
keys on the keyboard to scroll through the list until you find
the desired entry.

5. Press [Call] to call the selected entry. You can also double-
click the entry to call it.

6. To begin a new search, press [New Search].

Questions about Phone Book

What does the  icon mean?

When it appears next to an extension, it means that the
extension is designated as private. Attendants see the
number of the extension on their screens; other extension
users see only the user’s name (if available) on their display.

In the Source and Destination areas, a private extension appears
with a ‘p’ before the extension number—for example, p2030.
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Scratch Pad
The Scratch Pad is your own personal phone directory and Speed
Dial list. Use it to save telephone numbers for faster dialing or to
store the names and numbers of callers for future reference.

To enter information into the Scratch Pad

You can use the Scratch Pad while connected to a caller.

1. Press Scratch Pad.

2. Type a name, a telephone or extension number, and any
other information you want to save.

Include the Outside Line Access Code for external phone
numbers and omit spaces between digits.

3. Press [Save] to save the information.

To delete information in the Scratch Pad

•  Select the information using the mouse or the arrow keys,
and then press Delete.

To dial a telephone number in the Scratch Pad

•  Select the number you want to dial, and then press [Call].

Serial Call
If a caller wants to talk to several people in a row, use the Serial
Call feature. When the first call ends, the caller returns to the
console instead of being disconnected. You can then dial the next
call. The serial call keeps returning to the console until all the
intended calls have been made.

To set up a serial call for a caller in the Source or
Destination area:

1. Tell the caller to remain on the line after completing each call.

2. Press [Set Serial Call].

3. Dial an extension number.

4. Press Release.

The console is released from the call. When the extension you
dialed hangs up, the Serial Call returns to the console as a
Recall (see Recall on page 22).

To cancel a Serial Call

•  When the caller has finished the series of calls, press
[Cancel Serial].

If the serial call recalls and no one is there, it means the
caller has hung up.
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Trunk Group Status Display
Trunk Group Status Display is an optional feature that lets you
monitor traffic on the system. During peak traffic periods, some
users could experience problems making external calls and may
contact you to find out why. The Trunk Group Status Display
feature enables you to confirm excessive traffic as the most likely
cause. You can then tell users that the situation is temporary
and suggest that they try making their calls later.

You can display traffic information by specifying trunk group numbers or
the digits dialed to access them—for example, the digit 9.

The use of this feature does not disrupt call processing.

To display traffic information by trunk group number

1. Press Trunk Status.

2. Select Search by group number.

3. Enter the starting trunk group number, and then
press  [Search].

The displays shows a list of the trunk groups, the number of
trunks in each group, and the number of those trunks
currently in use—for example,

The Timestamp shows the time of your last search.

To display only the information on the trunks that are
accessed by dialing a given leading digit string

1. Press Trunk Status.

2. Select Search by dialed digits.

3. Enter the leading digit string—for example, area code “416.”

4. Press [Search].

After displaying traffic information you can...

•  Click [Print] to print status information for the displayed
trunk groups only.

•  Click [Print All] to print status information for all trunks
groups, including those not displayed.

Options
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System Speed Call
Frequently dialed telephone numbers may be saved for you and
other extension users for speed dialing. Use the table provided in
the Reference section to record the System Speed Call numbers
you will most likely need.

•  Dial the System Speed Call Number

The stored telephone number is dialed automatically.

Notes:

•  If you find that you are frequently dialing the same numbers,
add them to your personal Speed Call list in the Scratch Pad.
For more information, see page 38. You can also use the
Bulletin Board to store speed call numbers for use by all
attendants. For more information, see page 26.

•  Programming system speed call numbers is done by your
communications department and cannot be done from the
console.

Tone Signaling
You may have noticed that when you dial a number at your
console, you don’t hear any of the tones or pulses normally
associated with telephones. This is because your console
‘communicates’ with the rest of your telephone system with
different types of signals. However, there are times when you
need to send tones in order to complete your call. Typically,
special services such as voicemail require passwords or other
information in the form of tones before allowing access.

To generate tones

Once the connection is made and you are prompted to enter
digits:

1. Press Tones.

The Tones indicator in the Console Status area appears
dimmed when tone signaling is turned off.

2. Dial the code.

To turn off tone signaling

•  Press Release.

to disconnect your console from the call. Tone signaling stops
automatically.

Or

•  Press Tones again.
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Displaying and Changing Room
Information
Room information includes guest name, room occupancy and
condition status (Vacant, Clean, Out of Service, etc.), outgoing
call charges and restrictions, and the status of message waiting,
wake-up call, and other guest services.

To display, enter, or change room information

You can display, change, or enter new room information while
the console is idle, or when you are on a call to the room.

1. Press Guest Service, or if you are already on a call to the
room, press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not
necessary if you are already on a call to the room).

The display shows, for example:

In this example, John Smith from Mitel Corp is checked into
room 1026, allowed to make long distance calls, has a
message waiting and a wake-up call for 7:30 AM. The room is
occupied and clean and is unaffected by Call Blocking.

3. Make the required changes (if any), and then press [Save] to
save them.

After displaying the room information, you can...

•  Enter or change the name of the guest and the company or
group he or she is affiliated with. The guest’s name can have
a maximum of 20 characters.

•  Check the guest in or out (see page 46).

•  Change the room’s occupancy or condition status (see
page 45).

•  Enter, change, or clear the wake-up call time (see page 46).

•  Set or change outgoing call restrictions (see page 47).

•  Allow or block room-to-room calling (see page 47).

•  Clear the Message Cost and information for calls placed from
the room (see page 48).

Note:  Guest Services shows only whether Do Not Disturb (DND)
or Message Waiting (MW) are on or off. For information on
changing the status of these features, see pages 32 and 34.

Options
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Searching for Rooms
You can search for a room using the occupancy and condition
states as search parameters. This enables you to find, for
example, all rooms that are vacant and clean or that have maids
in them. You can also search using a guest’s last name to
determine which room they are in.

To search for rooms

1. Press Guest Service.

2. Do one of the following:

•  To display information for a specific room, use the
computer keyboard to type the room number in the Room
Number box.

•  To find rooms by occupancy and condition status, click
Room Status, and then select states from the Occupancy
and Condition lists.

To begin searching from a particular room, type the
number of the room in the Starting at room box.

•  To find a guest’s room, click Last Name of Guest, and
then type the guest’s last name.

3. Press [Search].

The screen shows, for example,

4. To view information for a room in the list, click to select it
and then press [Select]. Use the arrow keys or the Page Up
and Page Down keys to scroll through the rooms.

If a printer is attached to the console, you can print the
occupancy and condition status for all rooms in the hotel or
motel. For more information, see Printing Reports on page 48.

Changing Room Occupancy and
Condition Status
The room occupancy and condition states are as follows:

Occupancy Condition

Vacant

Occupied

Reserved

Clean

Not Clean

Maid Present (see note)

To Be Inspected

Out of Service

Note: The Maid status can also be changed
from the room by dialing a code.

To change a room’s occupancy and condition status

1. Press Guest Service, or if you are already on a call to the
room, press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not
necessary if you are already on a call to the room).

3. Press [Search].

4. Select the desired states from the Occupancy and Condition lists.

5. Press [Save] to save the changes.

Note: Depending on system programming, all ‘occupied and
clean’ rooms may automatically change to ‘occupied and not
clean’ at a specified time each day.
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Checking-In/Checking-Out
Checking in a guest changes the status of a room to Occupied;
checking out changes the room to Vacant. Both check-in and
check-out clear the guest name, affiliation and wake-up time (if
set). The Call Block and Call Restriction settings for the room are
also reset to values specified by system programming.

To check in or check out a guest

1. Press Guest Service, or if you are already on a call to the
room, press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not
necessary if you are already on a call to the room).

3. Press [Check-In] or [Check-Out].

4. Press [Save] to save the changes.

To cancel changes you made and return to the previous
screen, press [Previous].

Setting and Clearing Wake-up Calls
Both you and the guest can set, change, and cancel wake-up
calls for a guest room. The system does not distinguish whether a
wake-up call is set, changed, or canceled from the console or
guest room telephone. So, for example, a guest can cancel a
wake-up call that you set and vice-versa.

To set, change, or cancel a wake-up time while viewing the
guest room’s information

1. Click in the Wake-up box, and then type the hour and
minutes in 24-hour format. You must enter four digits—for
example 0630 for 6:30 AM (or 1830 for 6:30 PM)

To cancel a wake-up call, delete the time from the Wake-up
box.

2. Press [Save] to save the changes.

To set, change, or cancel a wake-up time when NOT viewing
the guest room’s information

1. Press Guest Service.

2. Enter the room number using the computer keyboard.

3. Follow steps 1 and 2 from the previous procedure.

Notes:

•  If the guest fails to answer the wake-up call, the system will
ring the room up to four more times at intervals of two to
seven minutes. If the guest still does not answer, the wake-
up call could be routed to the console.

•  Some display phones can set their own timed reminder. The
above procedures will also clear or change a reminder already
set by the user.

•  If a printer is attached to the console, a report may print each
time you set, change, or cancel a wake-up call.
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Setting Call Restrictions
You can control the type of telephone calls that guests can place
from the phones in their rooms. There are three levels of call
restriction: Internal, Local, and Long Distance.

The system provides three more levels (labeled Option 1, 2, and
3) that can be used to impose special call restrictions. Ask your
communications department for instructions about the use of
these restrictions.

To set or remove call restrictions for a room

1. Press Guest Service, or if you are already on a call to the
room, press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not
necessary if you are already on a call to the room).

3. Press [Search].

4. In the Call Restriction list, select one of the following:

•  Internal to allow internal calls only.

•  Local to allow internal and local calls.

•  Long Distance to allow internal, local, and long distance
calls

•  Option 1, Option 2, Option 3 to impose special call
restrictions determined by system programming.

Note: Your system may be programmed to automatically change
call restrictions for rooms at check-in and check-out time.

Blocking Room-to-Room Calls
Call Blocking stops guests from placing calls to other rooms. You
can control when Clock Blocking takes effect and the rooms
affected by it.

To control whether Call Blocking affects a room

1. Press Guest Service, or if you are already on a call to the
room, press the [Guest Service] softkey.

2. Enter the room extension using the computer keyboard (not
necessary if you are already on a call to the room).

3. Press [Search].

4. In the Call Block list, select the option you want.

5. Press [Save].

To turn Call Blocking on or off for the entire system

1. Select Guest Services on the Tools menu.

2. Select Toggle Call Block.

The Call Block indicator in the Console Status area appears
dimmed when Call Blocking is turned off.

Note: Your system may be programmed to turn Call Blocking on
and off for all affected rooms at certain times of the day and for
individual rooms at check-in/check-out time.
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Monitoring Guest Rooms
Guests can use their room phone as a listening device to monitor
their room from a remote station. The remote station can be an
attendant console, an extension, or an outside phone calling into
the system on a special line (i.e., a DISA trunk).

To use the console to listen in on a room that has room
monitoring activated

You can only monitor a room from an idle console.

1. Select Guest Services on the Tools menu.

2. Select Room Monitor.

3. Dial the room number using the console keypad.

4. Listen for three short beeps followed by audio from the room.

If room monitoring is not activated on the room phone, you
will hear reorder tone or a beep.

If you see ‘Monitor Busy,’ then another extension is already
monitoring the room.

If you see ‘Class Restricted’ or ‘Access Disallowed,’ then the
room cannot be monitored because of restrictions on the
console or the room phone.

To disconnect the console from the room

•  Press Cancel or Release.

Clearing the Message Register
The message register is a record of the number and cost of all
external calls placed from a guest room telephone. The system
uses meter pulses received from the local telephone company to
calculate costs. If pulses are not received, then only the number
of external calls are counted.

A guest’s message register is automatically cleared when the guest
is checked out. If a guest prefers to pay for calls on a daily basis,
you can manually clear the register after each payment is made.

To display or clear a room’s message register

1. Press Guest Service, or if you are already on a call to the
room, press the [Guest Service] softkey.

2. Use the computer keyboard to type the room number in the
Room Number box (not necessary if you are already on a call
to the room).

The Message Cost and Calls fields show the total cost and
number of all external calls placed from the room.

3. Click Clear to erase the Message Cost and Calls totals.

If a printer is attached to the console, a report may print showing
the contents of the register before it was cleared.

Printing Reports
If a printer is connected to the console, you can request printed
reports of message registers, room status and automatic wake-up
calls. Some reports print automatically. For example, whenever a
wake-up call is set, changed, or canceled, a record of the event is
printed.

To print a report

• On the Tools menu, select Guest Services followed by the
command that corresponds to the report that you want to print.
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Superset 700 vs.
Superconsole 2000
The information below summarizes the differences between the
Superset 700 and the Superconsole 2000 applications.

Keyboard changes
The Superconsole 2000 keypad and PC keyboard replace the single
Superset 700 keyboard. The following table lists the Superset 700
keys and their equivalents on the Superconsole 2000.

Note: You can use a mouse instead of keys to operate the
Superconsole 2000.

Superset 700 Key(s) Equivalent
Superconsole 2000 Key(s)

S1 – S7 F1 – F12 on computer
keyboard

Cursor Control Keys (← ↑  → ↓ ) ← ↑  → ↓  keys on computer
keyboard

� �

WORD  LINE Not supported/applicable

HELP HELP

APPL APPL

DESKTOP Not supported

REVRS Not supported/applicable

UNDEL Not supported

CALL NAME Not supported (use PHONE
BOOK instead)

PHONE BOOK PHONE BOOK

GUEST SERVICE GUEST SERVICE

PROG Not supported

OPER MODE OPERATOR MODE

STAT STATUS

MSG MESSAGE

PAGER PAGER

BELL None; use       on screen

TONES TONES

DEL ← Backspace

INSRT Not supported

SRCH Not supported

CLEAR Not supported

CMND Not supported

QUIT Not supported

CANCEL CANCEL

HOLD HOLD

RETRIEV RETRIEVE

RELEASE RELEASE

ANSWER ANSWER
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Screen changes
The Superconsole 2000 features a Windows-style interface with
support for a mouse. Other changes to the screen include:

•  Call Waiting indicator and time display moved to the bottom
of screen.

•  Console and system messages moved from the Command and
Response area to the Status area at the bottom of the screen.

•  Command entry feature removed.

•  Softkeys for Phone Book, Guest Services and Trunk Group
Status have moved from the bottom of the screen to below
the Tools area (i.e., the area of the screen that the Phone
Book and other tools occupy.)

•  The Phone Book cannot be resized.

• Indicator ( ) added to the Calls On Hold area to indicate which
call was last placed on Hold.

•  Call waiting icon ( ) added to the Calls On Hold area to
indicate that a call on Hold is recalling.

New features
The Superconsole 2000 adds these new features:

•  Scratch Pad

•  Bulletin Board

•  Recover Last Call

•  Transfer to Voicemail

•  Firmkey Programming

•  Call Answering Priority

•  Call Waiting Threshold

•  Synchronize Console Clock with PBX Clock

•  Guest room searching by guest name (Hotel/Motel feature)

•  Dual headset/handset jacks

Discontinued/Changed Features

Superset 700
Feature

Superconsole 2000
Equivalent

System Login (for CDE
programming)

File > Connect to CDE
command

Message Center None

Call by Name Phone Book

Command Line (Cmnd)
Functions

•  Change Screen Colours • Use Windows Control Panel

•  Change Alarm Colours •  None

•  Change Language •  Tools > Options command

•  Set System Date/Time •  Use File > Connect to CDE
command

•  Set Console Clock •  Tools > Options command

•  Operator Absent/Present

•  Warbler (Ringer) On/Off

•  Day/Night Service

•  Enable Headset/Handset
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Alarms
Your telephone system uses automatic monitoring and fault
diagnosis to check the system for faults.

An alarm status appearing in the upper-right corner of the screen
notifies you when a fault occurs. When there are no faults, this area
is blank. If a critical alarm occurs, you’ll hear a recurring beep.

The alarm display is cleared automatically when the fault is
corrected.

Alarm types
There are three classes of alarms: Minor, Major and Critical.

MINOR
There is a minor alarm within the telephone system, which
probably does not affect the telephone users.

MAJOR
An alarm affecting service has occurred, but calls can still be
made. Contact your communications department.

CRITICAL
The telephone system is not providing normal service and should
automatically switch itself to System Fail Transfer Mode (if this is
available on your system). You MUST contact your
communications department.

Greetings
Record your company’s preferred greetings for each of the
following situations.

Calls on
Outside
Lines

Calls On
Inside Lines

Recalls

Calls
Camped on
to a Line

Taking
Messages
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Rerouted Calls
Some users may decide to reroute their calls to your console, or
the system may be programmed to reroute certain types of calls
or all calls made at given times to your console.

The calls that are rerouted to your console may be one of
four types:

•  Calls a user has forwarded (Follow Me, Busy or No Answer).

•  Calls to a given number rerouted by system programming.

•  Calls on certain trunks if incoming calls on certain trunks
are always “transferred” to your console.

•  If the user dials a number that is rejected by the system for
any reason, Intercept Handling may be programmed to
reroute the call to your console.

Call Forwarding
When a user has forwarded his or her calls to your console,
incoming calls to that extension will ring your console. When you
answer, the called party information will appear in the
Destination area.

Note that the Destination area displays the name of the called
party, the called party’s number, and the type of Call Forwarding
that the called party programmed and that caused the call to be
rerouted to your console (Follow Me, Busy or No Answer).

Also, two softkeys are always available in this situation:
[Set Serial Call] and [Redial Dest]. Pressing [Redial Dest] will
automatically redial the called party, overriding the Call
Forwarding to your console.

System Rerouting
When the system is programmed to redirect calls to an extension
to your console at all times, the message “Call Forward - Always
Reroute” appears in the Destination area, below the user’s name
and extension number.

Transferred Calls
If you transfer an incoming call to an extension, and the
extension user transfers the call back to your console, the
message ‘‘Transferred’’ appears in the Destination area.

Intercept Handling
When a user dials a number that the system rejects, the call is
rerouted to your console. When you answer, the appropriate
Intercept Handling message displays in the Destination area. See
System Messages on page 62 for information about the messages
that may display in that situation.
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Class of Restriction
Each extension and trunk in the system is assigned a Class of
Restriction. As its name implies, a Class of Restriction (COR) may
restrict an extension (or a trunk) from accessing an external
route at a given time.

The extension’s COR is displayed in the Source or Destination
area of the console screen, along with its Class of Service and the
other information on the caller.

Here are a few examples on how the Class of Restriction can
affect users:

•  The extensions with a given COR may not dial outside the
system at all, having to ask the assistance of the attendant
to do so.

•  Extensions with another COR may have to go through the
attendant in order to dial long distance.

•  Extensions with yet another COR may only dial certain long-
distance numbers and at given times of the day.

•  Extensions with the least restrictions programmed could dial
anywhere at any time.

•  The extension’s COR may change with Day, Night 1 and
Night 2 services.

•  Routing may change according to the time of the day and the
day of the week, indicating different outside dialing privileges
according to the time of dialing.

Class of Service
Not all the features described in this Guide are available on your
console or on other extensions.

An extension’s Class of Service (COS) appears, with the
information about that extension, in the Source or Destination
area of the console screen.

Each COS defines which features an extension or console can
activate. The message “Feature not allowed” appears on the
console screen when you try to access a feature not allowed in
your or the extension’s COS.

Here are some examples of how a COS could affect users:

•  COS could change depending on whether the system is in
Day, Night 1, or Night 2 Service.

•  Extensions without an appropriate COS could be denied
access to certain features, such as Call Override, Paging
Access or Setting Message Waiting Notification.

•  You and other extension users may be required to enter an
Account Code for additional system access or when you want
to use your COS at a different extension.

•  Some extension users cannot be overridden.
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Feature Access Codes
FEATURE CODE

Account Code Access

- Verifiable ____________________________

- Non-Verifiable ____________________________

Associated Dataline Access ____________________________

Loopback ____________________________

Call Hold

- Retrieve ____________________________

- Remote - Retrieve ____________________________

Callback ____________________________

- Cancel ____________________________

Call Forward

- Busy (External) ____________________________

- Busy (Internal) ____________________________

- Follow Me ____________________________

- Follow Me Enchaining ____________________________

- I Am Here ____________________________

- No Answer (External) ____________________________

- No Answer (Internal) ____________________________

Call Park Remote Retrieve ____________________________

Call Privacy ____________________________

Camp-on ____________________________

- Retrieve ____________________________

FEATURE CODE

Clear All Features

- Remote ____________________________

Conference ____________________________

Do Not Disturb ____________________________

- Remote ____________________________

- Cancel Remote ____________________________

External Line Access ____________________________

Forced Release ____________________________

Last Number Redial ____________________________

Individual Trunk Access ____________________________

Message Waiting Inquire ____________________________

Message Notification ____________________________

- Cancel _____________________________

Override ____________________________

Paging ____________________________

Personal Speed Call

- Invoke ____________________________

- Store ____________________________

Pickup

- Dialed Call ____________________________

- Directed Call ____________________________

TAFAS -Remote Retrieve ____________________________
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Glossary
Account Code
A code you dial to access certain system features; to apply your
Class of Service (COS) at a different extension; or to associate a
caller with an SMDR record for accounting purposes.

ARS - Automatic Route Selection
This is an application that handles long distance call routing
automatically.

Broadcast Group
When a line has an appearance on another SUPERSET™
telephone, it is said to be in a broadcast group. This means that
all extensions with that line appearance have access to and may
use that line.

Call Privacy (Data Line Security)
A COS feature which prevents an extension from receiving Camp-
on Tone -- which could interfere with data transmission.

Camp-on
A feature allowing the system to queue calls directed to a busy
extension, then automatically connects the waiting party to the
extension when it becomes free. The busy extension user hears
Camp-on Tone indicating a call is camped-on. The waiting caller
is put on hold and hears music or silence.

Class of Restriction (COR)
Control of a station or trunk’s access to trunk circuits. A station
may have up to three different CORs specified for Day, Night 1 or
Night 2 Service.

Class of Service (COS)
A level of service defined by a specific set of features that controls
an extension’s access to these features. A station may have up to
three different COSs specified for Day, Night 1 or Night 2 Service.

Consultation Hold
A temporary hold applied to a call while an extension or console
user activates a feature or makes a call.

Customer Data Entry (CDE)
The entry of programmed data, specific to the customer’s
requirements. Customer data includes such items as directory
information, COS and COR allocations, and trunk data.

Direct Inward Dialing (DID)
This feature allows outside trunks to reach pre-programmed
extensions directly, without going through the Attendant console.

Direct Inward System Access (DISA)
A feature which allows callers to dial directly into the telephone
system and activate features and facilities.

External Line Access Code
A code which precedes a dialed number to indicate to the
telephone system that the telephone number is outside the
system.

Firmkeys
Keys on the console keypad that can be programmed to access
console features and system services.

Hunt Group
Extensions linked together in a group with a common (pilot)
telephone number as well as their own personal extension
numbers. Two types of hunting are available with your telephone
system: Circular Hunting and Terminal Hunting.

Circular Hunting: A new call to the Hunt Group is directed to the
first idle extension found after the extension which received the
last call. This provides equitable call distribution to all the
extensions.

Terminal Hunting: Hunting takes place in the order in which the
extensions were programmed into the hunt group. It always
starts with the first extension in the list and the hunting ends
with the first idle extension found.
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Line
A telephone communications channel between switching centers
or the Central Office and the PABX.

Night Answer Point(s)
An extension user can answer incoming calls ringing the Night
Answer Point by dialing the TAFAS code.

Night Service
A system mode of operation that routes incoming calls to the
Night Answer Point(s) when the system is in Night Service and
the Attendant consoles are in Absent mode.

Pickup Group
Extensions located in one area, or with similar departmental
functions, are often placed in the same answer group.

Recall
A call returns to the console for further handling by the
attendant.

SMDR - Station Message Detail Recording
This is an application that automatically logs call information
such as “length of call” and “caller extension number”, among
other things.

Switchhook Flash
Used by extension users to signal the telephone system that they
want to activate a feature.

TAFAS Code
(Trunk Answer From Any Station) A code used to answer calls
ringing the Night Answer Point(s).

Trunk
An outside line which links two switching systems. This link can
be between one or more private telephone systems and/or
between your private system and the public telephone system
(Central Office).
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Hunt Groups
Dialing a Hunt Group Pilot Number either from the keypad or
through the Phone Book feature, connects you to the first
available extension in that area. Contact your communications
department for more information

Pilot
Number

Hunt Group
Name

Extensions

Paging Zones
Use this table to record the paging zones your system uses.
Contact your communications department for more information.

Location Zone Code

All Zones 00

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15
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System Speed Call List
Name Number
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System Messages
These messages appear in the various areas of your screen.

Absent Feature Disallowed for Last Attendant.
Select Night Service
As the last or only attendant in the group, you cannot place your
console into absent mode.

Access Disallowed
The feature access code you’ve dialed is not available to an
Attendant.

Attendant Gr(oup)
Displayed when one attendant calls another number belonging to
one or more attendants.

Attendant Operation Re-enabled
You are back in the Operator screen from Program mode.

Broadcast Gr(oup)
Group of extensions sharing the same line. Actually, every line in
the system is part of a broadcast group, even if it appears on only
one extension (private lines, for example).

Busy
The number you just dialed is busy.

Call Announce Mode
The SUPERSET 4 telephone you have overridden has a Call
Announce facility and you are overriding without being
conferenced.

Callback - Recall
The busy extension or trunk you requested the system to monitor
is now available.

Callback Queue Full
Your request for a Callback has been denied because of
insufficient system resources.

Call Forward - Always Reroute
This extension user has all calls rerouted to you.

Call Forward - Busy
This extension user is busy and has forwarded calls (Call
Forward - Call Fwd Busy) to you.

Call Forward - Follow Me
This extension user has all calls forwarded to you (Call Forward -
Follow Me).

Call Forward - No Answer
This extension user is not available, and has forwarded calls (Call
Forward - No Answer) to you.

Cancel All Features for Station # :
Enter the number of the extension for which you wish to cancel
all features.

Cancel CFFM for Station # :
Enter the number of the extension for which you wish to cancel
Call Forward- Follow Me.

Cancel Do Not Disturb for All Stations ... Completed
Confirms that the requested action has been taken.

Cancel DND for Station # :
Enter the number of the extension for which you wish to cancel
Do Not Disturb.

Cancel Forwarding for All Stations ... Completed
Confirms that the requested action has been taken.

Cancel All CFWD for Station # :
Enter the number of the extension for which you wish to cancel
all types of Call Forwarding.
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Cancel Operation Abandoned
You have just pressed Quit or [No] to exit from your request
without cancelling anything.

Cancelling Do Not Disturb for All Stations
Your request is in progress.

Cancelling Forwarding for All Stations
Your request is in progress.

Cannot Activate Feature if a Party in DESTINATION
Release party in DEST and try again.

Cannot Put Connected Party On Consultation Hold
You already have a party on Consultation Hold, and you cannot
perform certain functions - for example, activating message
waiting for an extension until you clear the destination field.

Check MSG Waiting for Station # :
Enter the number of the station for which you want to check the
message waiting notification(s).

Completed
Confirmation message when the number you’ve entered is valid
and the action requested has been taken.

Class Restricted
Your Class of Service does not allow this feature.

Conference
Indication that a conference has been set up or is on hold.

Connected
Confirmation message when your call is connected to a data call.

Connected to Pager
Confirmation message that you have accessed the paging zone
and can make your announcement.

COR
Indicates the Class of Restriction applicable to that station or
trunk.

COS
Indicates the Class of Service applicable to that station or trunk.

COS Violation
The caller tried to access an unavailable feature. Intercept
handling has rerouted the call to your console.

Data Line
Equipment name displayed when a data line is called.

Data Group
Equipment name when a data group is called.

Directory Number Out of Service
The caller has dialed a directory number that does not exist. The
call has been rerouted to your console.

Do Not Disturb
The extension user you dialed has activated Do Not Disturb. You
cannot call this extension unless you use the override feature.

External
Indicates a call from outside your system (a trunk call).

Feature Activated
A feature such as Do Not Disturb is activated.

Feature Cancelled
A feature such as Do Not Disturb is cancelled.

Feature Not Allowed
There is a restriction preventing you from using this feature, or
performing this action.
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Guest Service
Part of the Hotel/Motel Feature package. This prompt appears in
several attendant mode operations. Pressing it places the console
in Guest Service mode immediately.

Headset or handset required for attendant operation
Plug in your headset or handset.

Holding Party Locked Out
You have left the caller on Key hold for too long, and the call is
returning to your console.

Hunt Group
Indicates that a station or trunk is a member of a hunt group.

In Auto-Answer Mode
The SUPERSET 4 telephone you have reached has activated
“Auto-Answer”.

Interconnect Failure
There are local interconnect restrictions which do not allow you
to connect the requested devices.

Interconnect Restriction
The caller’s extension is programmed with Interconnect Restriction.
Intercept Handling has rerouted the call to your console.

Internal
Indicates a call from inside your system.

Invalid Account Code
Verify your Account Code and try again.

Invalid Dialing
Verify what you dialed and try again.

Invalid Number
You attempted to dial an incorrect number. Verify your number
and try again.

Invalid Trunk Number
You attempted to select an incorrect or out-of-service trunk.

Language selection option not installed
The language you requested is not installed on your telephone
system.

Locked out
Indicates a station which is out of service and cannot be accessed
or make a call.

Modem
You are connected to a modem.

Modem Busy
The modem dialed is already busy.

Modem Call
Confirmation message when you dial a modem.

Modem Group
Indicates that the modem you are connected to is in a group of
modems.

Modem Out of Service
The modem dialed is out of service and cannot be used at this time.

Monitor Busy
The extension you are trying to monitor is already being monitored
from another station.

MSG Waiting
After pressing the [Check MSG Waiting] softkey, this indicates
that the extension has message(s) waiting.

MSG Waiting OFF
Confirmation that you turned off an extension’s message waiting
indicator by pressing the [Clear MSG Waiting] softkey.
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MSG Waiting ON
Confirmation that you turned on an extension’s message waiting
indicator by pressing the [Set MSG Waiting] softkey.

Must CANCEL before dialling
Press Cancel on the console keypad, and the try dialing again.

Must Press Retrieve Key then 1 - 6 or * to Retrieve
Held Call. Request Ignored.
Try again, but dial the position number of held call (1-6), or dial *
(to retrieve the longest held call).

Must RELEASE before changing language
You cannot change the language while talking to someone. End
your call before proceeding.

Network
Shows if you have dialed over a MSDN/DPNSS (Digital Private
Network Signalling System) line, which connects two SX-2000
PABXs in a private network.

No Answer
There was no answer at the extension called.

No One on Hold at Specified Hold Position
Verify your position number and try again.

Not Ready
The data call cannot be completed at this time. Try again later.

Operator Absent
If you have changed the status of your console to Operator
Absent, this message is displayed in the DEST area of the console
of another attendant who calls you.

Out of Service
The device you dialed is not in service.

Overriding
Confirmation message when you override a busy party.

Page Zone Busy
The zone number you dialed is busy; dial another zone code, or
try again later.

Page Zone Unassigned
Verify the number you dialed. If it still doesn’t work, contact your
communications department.

Press “Yes” to Confirm Request or “No” to Quit
Press the appropriate softkey.

Problems in changing language
System problem. Contact your communications department.

Recall
A previously extended call has returned to your console after a
time-out period.

Recall – Busy
A previously extended call has returned to your console because
the extension is busy.

Recall - Busy, Campon Not Allowed
There is a restriction preventing you from camping a call on to
the requested destination.

Recall – No Answer
A previously extended call has returned to your console because
the extension did not answer.

Remove MSG Waiting for Station # :
Enter the number of the extension from which you wish to
remove a Message Waiting notification.

Request Denied
Verify what you’ve just done, and try again.

Ringing
The number you dialed is ringing.
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Route
You are calling a route.

Seized
Confirmation message when you access a trunk.

Select Paging Zone
Enter the number of the zone which you wish to access by
the Pager.

Selected Operation Not Being Acknowledged.
Request is Abandoned
The telephone system is not processing your request. Try again
later or verify your operation.

Selected Trunk
Indicates that a particular trunk has been selected for use.

Serial
Indicates a caller who wants to talk to several people in
succession.

Serial - Busy
The Serial call has returned to your console because the
destination is busy.

Serial - No Answer
The Serial call has returned to your console because the
destination did not answer before a predetermined period of time.

Serial - Recall
The Serial call you made was successful.

Set MSG waiting for Station # :
Enter the number of the extension on which you wish to set a
Message Waiting notification.

Setup DND for Station # :
Enter the number of the extension for which you wish to set up
Do Not Disturb.

SUPERSET x...x
The station in question is a SUPERSET telephone.

SUPERSET 7 Console
You are connected to a SUPERSET 7 console.

SUPERSET 700 Console
You are connected to a SUPERSET 700 console.

SUPERSET 7000 Console
You are connected to a SUPERSET 7000 console.

SC 1000 Console
You are connected to a SUPERCONSOLE 1000.

System is in Night Service 1
The call has been rerouted because the system is in
Night Service 1.

System is in Night Service 2
The call has been rerouted because the system is in
Night Service 2.

System Unable to Complete Selected Operation.
Please Try Again
The telephone system is not processing your request. Try again
later.

Toll Denial - Illegal Dialing
The caller dialed a toll number wrong, and the call has been
rerouted to your console.

Toll Denial - Route Restriction
The caller tried to dial a toll number not allowed in his/her Class
of Restriction and the call has been rerouted to your console.

Tone Timer Expired
You’ve been listening to busy or ringing tone for too long and the
system has disconnected your call. Cancel the call and try again.
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Transferred
The call has been transferred from an internal extension.

Trunk Access Denied
You are not allowed access to the trunk because of your or the
trunk’s Class of Restriction.

Unable to Setup or Add to Conference
Either:

•  there is a restriction in your COS/COR preventing you from
setting up a conference;

•  you have reached the maximum number of trunks allowed in
a conference;

•  you have reached the maximum number of conferees allowed
in a conference; or

•  you cannot have two attendants in a conference.

Unassigned Directory Number
The number you dialed is not recognized by the telephone
system. Verify your number and try again.

Wake-up Call Not Acknowledged
Part of the Hotel/Motel Feature package. The guest has not
answered the automatic wake-up. (Note: The Hotel/Motel
package is an optional feature.)

Wake-up Call - System Error
Part of the Hotel/Motel Feature package. The Wake-up function
is not operating properly. Contact your communications
department.

You are already using the selected language. Language not
changed.
You made a mistake in selecting the language. Repeat the
procedure.



68 ▼ Reference

Telephone Directory
Name Number

Trunk Numbers
Use this table to record the trunk numbers your system uses.
Contact your communications department for more information
about the trunk numbers.

Trunk Number Use
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Index
A

Absent, Operator status, 36
Access Codes, programming, 33
Account Codes, 26
Answer calls, 14
Answer key, 14
Answering priority, changing, 27
Application area, 5
Associated data line, 30

B
Bulletin Board, 26
Busy number, transfer to, 18

C
Call Answer Priority, 27
Call Block, 47
Call Forwarding, canceling on

extensions, 29
Call Park, 28
Call restrictions, setting for guest

rooms, 47
Callback, 16
Cancel
All features on extensions, 29
Call Forwarding on extensions, 29
Do Not Disturb on extensions, 32
Message Waiting on extensions, 34

Check-in/Check-out. See Guest Rooms
Class of Restriction, 56
Class of Service (COS), 56
Clear All Features, 29

Close console. See
Conference calls, 21
Console
Adjustments, 9
components, 4
Keypad, 6
Keys, 6
Language, 10
Ringer, 9
Screen, 5
Starting and closing, 8
Time, 10

COR (Class or Restriction), 56
COS (Class of Service, 56

D
Data Calls, 30
Day and Night Service, 31
Dialing telephone numbers, 16
DND, 32
Do Not Disturb, 32

E
Errors
Correcting, 17

Extend calls. See Transfer calls

F
Feature Access Codes, 33
Features, clear all, 29
Firmkeys, 6
Firmkeys, programming, 33
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G
Guest room
Find rooms, 45

Guest Room
Condition status, change, 45
Display/change room information, 44
Occupany status, change, 45

Guest Rooms
Call Blocking, 47
Call Restrictions for, 47
Check-in/Check-out, 46
Message Register, clear, 48
Monitoring, 48
Reports, printing, 48
Wake-up calls, 46

H
Handset, 7
Enabling, 10
Volume, adjusting, 10

Headset
Enabling, 10
Volume, adjusting, 10

Hold, place call on, 20
Hunt Groups, 60

K
Keypad, console, 6

L
Language, changing on console, 10

M
Message Register, clearing for guest

rooms, 48
Message Waiting, 34
Mistakes, correcting, 17
Monitoring
Guest Rooms, 48

N
Night and Day Service, 31
Non-verified Account Code, 26

O
Operator Present/Absent status, 36
Override, 35

P
Paging, 36
Paging Zones, 60
Park, Call, 28
Phone Book, 37
Present, Operator status, 36
Programming Firmkeys, 33

R
Recalls, 20, 22
Recover, last call released, 22
Rerouted Calls, 55
Retrieve
Calls on hold, 20

Ringer
Mute, 9
Volume, adjusting, 9

Room-to-room calls, blocking, 47
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S
Scratch Pad, 38
Selective call answer, 14
Serial Call, 38
Sofkeys, 7
Softkeys, 4, 5, 14
Speed Call, System, 40
Start console, 8
Status area, 5
Status Display, Trunk Group, 39
System Messages, 62
System Speed Call, 40
System Speed Call List, 61

T
Telephone Directory, 68
Telephone numbers, dialing, 16
Time, setting, 10

Tone Signaling, 40
Traffic Monitoring. See Trunk Group

Status Display
Transfer calls, 18
Trunk Numbers, 68
Trunks
Direct access, 17

V
Verified Account Code, 26
Volume
Headset/Handset, adjusting, 10
Ringer, 9

W
Wake-up calls. See Guest Rooms




